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4.2.6 RINGKASAN

Prediksi Tingkat Bahaya Erosi Menggunakan Pemodelan Universal Soil Loss
Equation (USLE) dan ArcGIS di Wilayah Administratif UPT PSDA
Surabaya; Ugis Likhul Nuris, 111710201054; 2017: 44 Halaman; Jurusan Teknik
Pertanian Fakultas Teknologi Pertanian Universitas Jember

Erosi tanah merupakan kejadian alam yang pasti terjadi dipermukaan
bumi. Erosi terjadi akibat adanya penghancuran agregat tanah menjadi partikel
tanah yang terangkut atau terkikis karena adanya pergerakan air atau angin, dan
diendapkan di tempat lain.Erosi dapat dipercepat akibat dari ulah manusia yang
tidak dapat mengelola lingkungan. Perlu dilakukan perhitungan prediksi laju erosi
untuk mengetahui tingkat bahaya erosi pada suatu wilayah. Universal Soil Loss
Equation (USLE) merupakan salah satu metode yang digunakan untuk
menghhitung rata-rata laju erosi jangka panjang pada suatu bidang tanah tertentu.
USLE memiliki beberapa input yang meliputi erosivitas hujan (R), erodibilitas
tanah (K), panjang dan kemiringan lereng (LS), indeks pengelolaan tanaman (C),
dan tindakan konseravasi tanah (P). Penelitian prediksi laju erosi ini bertujuan
untuk a) Menghitung besar erosi, b) Klasifikasi tingkat bahaya erosi, dan c)
Pemetaan lahan yang menunjukkan daerah yang rawan terjadi erosi.

Hasil dari penelitian yang dilakukan bahwa laju erosi yang terjadi wilayah
UPT PSDA Surabaya antara 0 - 4319814,4 ton/ tahun dengan total laju erosi
1637,08 ton/ Ha/ tahun. Sedangkan rata-rata laju erosi diperoleh nilai 44,54 ton/
Ha/ tahun. Hal ini menunjukkan tingkat bahaya erosi yang tinggi dari erosi yang
diperbolehkan. Penggunaan tata guna lahan di wilayah UPT PSDA Surabaya
pemukiman memiliki luasan 38575,078 Ha. Hal ini menunjukkan kurangnya
daerah hutan dan lahan kosong. Dengan kurangnya daerah konservasi maka
mungkinkan terjadinya erosi. Karena kurangnya daerah resapan air dan penahan
laju erosi. Di wilayah UPT PSDA Surabaya mencakup lima kelas bahaya erosi
yaitu sangat ringan (1,32 ton/ Ha/ tahun), ringan (34,35 ton/ Ha/ tahun), sedang
(110,15 ton/ Ha/ tahun), berat (304,92 ton/ Ha/ tahun), dan sangat berat (1186,33
ton/ Ha/ tahun).
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4.277 SUMMARY

The Prediction on Erosion Rate UsingUniversal Soil Loss Equation (USLE)
and ArcGIS in Administrative Area of UPT PSDA Surabaya; Ugis Likhul
Nuris, 111710201054; 2016: 44 pages; Departement of Agricultural Engineering,
Faculty of Agricultural Technology, Jember University

The objectives of this research was to esstimate soil erosion rate and to
classify areas based on soil erosion rate. Study area was the administrative area
of UPT PSDA Surabaya (total modeled area was about 324.158,96 Ha). The
erosion map was predicted by means of USLE on the top of ArcGIS package. The
input data for this research consist of: daily rainfall, soil type maps, land use
maps, ASTER G DEM?2. Furthermore, landscape fotos at severalsite were
captured by camera to compare the calculated erosion rate and the actual
landscape. The results showed that total erosion rate in the study area was 44,54
ton/ha/ year. The result also showed that, research area was dominated by very
low class of erosion rate (76,96%), followed by low (10,78%), moderates
(6,91%), high (3,55%) and very high erosion rate(1,80%).
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4.2.11 BAB 1. PENDAHULUAN

1.1 Latar Belakang

Erosi tanah merupakan kejadian alam yang pasti terjadi dipermukaan
bumi. Besarnya erosi sangat tergantung dari faktor-faktor alam ditempat
terjadinya erosi tersebut, akan tetapi saat ini manusia juga berperan penting
terhadap terjadinya erosi. Adapun faktor-faktor alam yang mempengaruhi erosi
adalah erodibilitas tanah, karakteristik dan iklim. Erosi adalah hilangnya atau
terkikisnya tanah atau bagian-bagian tanah dari suatu tempat oleh air atau angin
(Arsyad, 2010:5).

Dalam sektor pertanian, erosi sangat membahayakan bahkan menjadi
masalah yang dapat mengganggu kinerja di bidang pertanian. Tanah yang terkikis
dapat terbawa air dan terendap di saluran, sehingga dapat menghambat laju air.
Tanah yang terkikis juga dapat menghambat saluran di daerah bendungan maupun
waduk.Arsyad (2010:5) mengatakan bahwa, erosi juga dapat menurunkan sifat
kimia dan fisik tanah seperti kehilangan unsur hara, kehilangan bahan organik,
dan mengurangi kemantapan tanah sehingga banyak lahan pertanian memiliki
produktivitas rendah.

Pada wilayah aliran sungai Butung Paketingan khususnya daerah
Mojokerto terdapat lahan kering pada tahun 2011 sebesar 11834,00 Ha. Angka
tersebut menunjukkan kenaikan tingkat lahan kering karena tahun 2007 dan 2008
sebesar 2250,00 Ha, hal ini memicu terjadinya erosi (Bappenas, 2012).

Pengelolaan erosi dan sedimentasi mengacu pada pola pengelolaan sumber
daya air dengan tetap memperhatikan penataa ruang dan pengurusan hutan.
Metode (USLE) Universal Soil Loss Equation merupakan metode yang sudah
lama digunakan untuk memperediksi laju erosi. Dengan melihat Persamaan USLE
dapat diketahui bahwa untuk menekan laju erosi maka upaya-upaya yang

dilakukan adalah menguragi besarnya erosi yang ada pada suatu lokasi.

1.2 Rumusan Masalah
Erosi dapat terjadi karena adanya tanah yang tidak kuat untuk menahan

laju air dan angin. Erosi dapat dipercepat akibat dari ulah manusia yang tidak
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dapat mengelola lingkungan. Pemanfaatan tata guna lahan yang tidak
memeperhatikan tindakan konservasi belum bisa mengatasi terjadinya erosi.

Pada kawasan UPT PSDA Surabaya terdapat lahan kritis yang disebabkan
oleh pencemaran industri, limbah penduduk, dan alih fungsi lahan. Lahan kritis ini
dapat mengakibatkan banjir dan erosi, karena infiltrasi tanah berkurang dan
menjadikan limpasan permukaan. Kurangnya infiltrasi mengakibatkan tanah
terbawa oleh aliran air. Salah satu kawasan UPT PSDA Surabaya khususnya
diwilayah Mojokerto terdapat beberapa daerah yang paling sering terjadi
bencana tanah longsor dan banjir bandang, pada tahun 2002, 2004, 2006,
dan 2012 adalah Kecamatan Pacet dan Kecamatan Trawas Kabupaten
Mojokerto (BAPPENAS, 2012),

Penelitian ini difokuskan pada aplikasi pemodelan USLE untuk pemetaan
tingkat bahaya erosi di UPT PSDA Surabaya dengan wilayah kajian Sidoarjo,
Surabaya, dan Mojokerto.

1.3 Tujuan Penelitian
Tujuan penelitianini adalah sebagai berikut.
1. menghitung besar erosi,
2. klasifikasi tingkat bahaya erosi,

3. pemetaan lahan yang menunjukkan daerah yang rawan terjadi erosi.

1.4 Manfaat Penelitian
Manfaat penelitian ini adalah untuk memberikan informasi mengenai

tingkat bahaya erosi di wilayah UPT PSDA Surabaya.
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4.2.12 BAB 2. TINJAUAN PUSTAKA

2.1 Erosi

Erosi adalah hilangnya atau terkikisnya tanah atau bagian-bagian tanah
dari suatu tempat oleh air atau angin. Di daerah beriklim basah faktor yang
mempengaruhi erosi adalah hujan. Erosi menyebabkan hilangnya lapisan tanah
yang subur dan baik untuk pertumbuhan tanaman serta berkuangnya kemampuan
tanah untuk menyerap dan menahan air (Arsyad, 2010:5).

Menurut Arsyad (2010:50), erosi merupakan peristiwa pindahnya atau
terangkutnya tanah atau bagian-bagian tanah dari suatu tempat ke tempat lain oleh
media alami. Pada peristiwa erosi, tanah atau bagian-bagian tanah pada suatu
tempat terkikis dan terangkut yang kemudian diendapkan di tempat lain.

Proses erosi bersifat tidak liner. Erosi yang terjadi meningkatkan aliran
permukaan karena berkurangnya kapasitas infiltrasi tanah. Pada asasnya dapat
disimpulkan bahwa erosi adalah akibat interaksi kerja antara faktor-faktor iklim,
topografi, tumbuhan (vegetasi), dan manusia (Arsyad, 2010:102).

Beberapa macam erosi yang dikenal dalam kamus konservasi tanah dan
air, yaitu erosi geologi, erosi normal, dan erosi dipercepat. Erosi normal juga
disebut erosi geologi atau erosi alami merupakan proses-proses pengangkutan
tanah yang terjadi di bawah keadaan vegetasi alami. Biasanya terjadi dengan laju
yang lambat yang memungkinkan terbentuknya tanah yang tebal yang mampu
mendukung pertumbuhan vegetasi secara normal. Erosi dipercepat adalah
pengangkutan tanah yang menimbulkan kerusakan tanah sebagai akibat perbuatan
manusia yang mengganggu keseimbangan antara proses pembentukan dan

pengangkutan tanah (Arsyad, 2010:51).
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2.2 Bentuk Erosi
Menurut Arsyad (2010:51) terdapat enam bentuk erosi sebagai berikut.

1. Erosi Lembar (sheet erosion)
Pengangkutan lapisan tanah yang merata tebalnya dari suatu permukaan
bidang tanah. Kekuatan jatuh butir-butir hujan dan aliran air di permukaan
tanah merupakan penyebab utama erosi ini.
2. Erosi Alur (7iil erosion)
Erosi alur terjadi karena air terkonsentrasi dan mengalir pada tempat-tempat
tertentu di permukaan tanah sehingga pemindahan tanah lebih banyak terjadi.
Erosi ini biasa terjadi pada tanah yang ditanami dengan tanaman yang
ditanam berbaris menurut lereng.
3. Erosi Parit (gully erosion)
Proses terjadinya erosi parit sama dengan erosi alur, tetapi saluran-saluran
yang terbentuk sudah terlalu dalam sehingga perlu pengolahan tanah yang
serius. Daerah yang mengalami erosi parit sulit untuk dijadikan lahan
pertanian.
4. Erosi Tebing Sungai (stream bank erosion)
Terjadi akibat pengikisan air yang mengalir dari bagian atas tebing atau oleh
terjangan arus air yang kuat pada saluran atau selokan sungai. Erosi tebing
sungai akan lebih hebat terjadi jika vegetasi penutup tebing telah habis.
5. Longsor (landslide)
Erosi yang pengangkutan atau pemindahan tanahnya terjadi dalam volume
yang besar. Longsor terjadi akibat meluncurnya suatu volume tanah di atas
suatu lapisan agak kedap air yang jenuh air.
6. Erosi Internal
Terangkutnya butir-butir perimer ke dalam celah-celah atau pori-poritanah
sehingga tanah menjadi kedap air dan udara. Erosi internal mungkin tidak
menyebabkan kerusakan yang serius karena bagian tanah tidak hilang ke

tempat lain.
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2.3 Daerah Aliran Sungai (DAS)

Daerah Aliran Sungai DAS adalah suatu wilayah daratan yang secara
topografi dibatasi oleh punggung-punggung gunung yang menampung dan
menyimpan air hujan untuk kemudian menyalurkannya kelaut melalui sungai
utama. Dalam DAS, jalur-jalur sungai dengan tanpa cabang pada ujung
pengalihan disebut orde pertama sungai. Penggabungan dua orde pertama sungai
yang berbentuk orde kedua, dua orde kedua sungai membentuk orde ketiga dan
seterusnya. Bentuk DAS akan mempengaruhi debit pengaliran, pola banjir dan
debit. Beberapa bentuk DAS yang terdapat di Indonesia secara skematis sebagai
berikut :

1. Berbentuk Bulu Burung

Jalur daerah di kiri kanan sungai utama langsung mengalir ke sungai
utama. DAS ini memiliki debit banjir yang relatif kecil, namun banjir yang terjadi
berlangsung relatif lama. Hal ini karena waktu tiba banjir dari anak-anak sungai

berbeda-beda (Sosrodarsono dan Takeda, 1999:169).

Gambar 2.1DAS Bentuk Bul-u Burung
(Sumber: Sosrodarsono dan Takeda, 1999:169)

2. Berbentuk Menyebar (Radial)

Daerah pengaliran yang berbentuk kipas atau lingkaran dan di mana anak-
anak sungainya berpusat ke suatu titik secara radial. Daerah pengaliran dengan
corak sedemikian mempunyai banjir yang besar di daerah titik pertemuan anak-

anak sungai (Sosrodarsono dan Takeda, 1999:170).
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Gambar 2.2 DAS Bentuk Menyebar (Radial)
(Sumber: Sosrodarsono dan Takeda, 1999:169)

3. Berbentuk Sejajar (Pararel)

Bentuk ini mempunyai karakteristik dimana dua jalur daerah pengaliran
yang bersatu di bagian hilir. DAS dengan karakteristik demikian, jika terjadi
banjir maka akan terjadi dibagian hilir titik-titik pertemuan sungai (Sosrodarsono

dan Takeda, 1999:170).

Gambar 2.3 DAS Bentuk Sejajar/Pararel
(Sumber: Sosrodarsono dan Takeda, 1999:169)

2.4 Prediksi Erosi Menggunakan Universal Soil Loss Equation (USLE)

Suatu model parametrik untuk memprediksi erosi dari suatu bidang tanah
adalah Universal Soil Loss Equation (USLE) yang memungkinkan perencana
menduga laju rata-rata erosi suatu tanah tertentu pada suatu kecuraman lereng
dengan pola hujan tertentu untuk setiap macam pertanaman dan tindakan
pengelolaan atau tindakan konservasi tanah yang mungkin dilakukan atau yang
sedang dipergunakan (Arsyad, 2010:248).

Prediksi erosi dengan metode Universal Soil Loss Equation (USLE)
diperoleh dari hubungan antara faktor-faktor penyebab erosi seperti Persamaan
2.1 berikut:

AZRXKXLSX CPoiiiiiteeeeeee e (2.1)

Keteranagan:
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A : banyaknya tanah tererosi per satuan luas per satuan waktu (ton/tahun)
R : faktor erosivitas hujan dan aliran permukaan (MJ.mm/tahun)

K : faktor erodibilitas tanah (ton/MJ.mm)

LS : faktor panjang dan kemiringan lereng

CP : faktor tanaman penutup dan tindakan konservasi lahan

4.2.13 2.4.1 Faktor Erosivitas (R)

Erosivitas adalah kemampuan hujan merusak tanah atau menyebabkan
tanah tererosi. Di Indonesia Bols menentukan Persamaan untuk menghitung nilai
R berdasarkan pada studi empiris dari rata-rata tahunan curah hujan (P) dalam
satuan mm (Teh, 2011). Besarnya erosivitas hujan pertahun dapat dihitung

menggunakan Persamaan berikut:

Berikut merupakanpersamaan untuk menghitung rata — rata curah hujan

(mm) dalam 10 tahun :

................................ (2.3)
Keterangan:
EI = erosivitas hujan
R = nilai erosivitas
D = jumlah hujan harian
Max R = hujan maksimal dalam satu hari selama 24 jam
= rata-rata curah hujan (mm)
n = jumlah tahun

= curah hujan di setiap tahun dalam lima tahun (mm)

4.2.14 2.4.2 Faktor Erodibilitas (K)
Erodibilitas (K) tanah adalah mudah tidaknya tanah mengalami erosi, yang
di tentukan oleh berbagai sifat fisik dan kimia tanah. Tanah yang memiliki

erodibilitas tinggi akan lebih cepat tererosi dibandingkan tanah yang memiliki
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erodibilitas rendah (Sutedjo dan Kartasapoetra, 1991:21-22). Klasifikasi nilai K

dan besar erosi seperti yang disajikan pada Tabel 2.1 berikut ini.

Tabel 2.1Nilai Erodibilitas Tanah (K)

NO  Jenis Klasifikasi tanah 12l K
rata-rata

1 Latosol merah 0,12

2 Latosol merah kuning 260

3 Latosol cokelat 23

4 Latosol 0,31

5 Regosol 0,12-0,16
6  Regosol 0,29

7 Regosol 0,31

8  Gley humic 0,13

9 Gley humic 0,26
10  Gley humic 0,2

11 Lithosol 0,29
12 Grumosol 0,21

13 Hydromorf abu-abu 0,2

Sumber: Asdak, (2002: 365)
4.2.15 2.43 Faktor Panjang Lereng (L) dan Kemiringan Lereng (S)

Faktor panjang lereng (L) diukur dari tempat mulai terjadinya aliran air
diatas permukaan tanah sampai ke tempat mulai terjadinya pengendapan
disebabkan oleh berkurangnya kecuraman lereng. Faktor kemiringan lereng (S)
dinyatakan dalam drajat sudut lereng atau persen. Apabila lereng 100% maka
memiliki sudut 45° (Arsyad, 2010:365-366).

Faktor panjang lereng (L) dan kemiringan lereng (S) merupakan sumber
terjadinya kesalahan terbesar untuk perapan Persamaan USLE. Persamaan untuk
menghitung nilai LS dengan memanfaatkan data DEM pada SIG mengacu pada
Engel (2003), yaitu:

......................................................... 2.3)
Keterangan:

LS = faktor lereng

X = panjang lereng

m = variabel

() = kemiringan lereng (slope) (%)

CZ  =jumlah pixel
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Nilai kemiringan lereng diklasifikasikan seperti pada Tabel 2.2 berikut.

Tabel 2.2 Klasifikasi Kemiringan lereng

Kelas Kemiringan Diskripsi
I <5 Datar
11 5-15 Landai
I 15-35 Bergelombang
v 35-50 Curam
\4 > 50 Sangat Curam

Sumber : Bappenas, (2012): II- 14

4.2.16 2.44 Vegetasi Penutupan Lahan (C)

Faktor C menunjukkan pengaruh keseluruhan dari vegetasi, kondisi
permukaan tanah, dan pengelolaan lahan terhadap besarnya tanah yang hilang
(erosi). Faktor pengelolaan tanaman menggambarkan perbandingan antara
besarnya erosi lahan yang ditanami dengan tanaman tertentu dengan pengelolaan
terhadap besarnya erosi tanah yang tidak ditanami dan diolah bersih dalam
keadaan identik.

Faktor tanaman penutup lahan merupakan perbandingan antar besarnya
erosi dari suatu lahan dengan penutup tanaman dengan manajemen tanaman
tertentu terhadap lahan yang identik tanpa tanaman atau tidak berdimensi (Arsyad,

2010:366).

4.2.17 2.4.5 Faktor Konservasi Tanah (P)

Faktor P adalah nisbah besarnya erosi dari tanah dengan suatu tindakan
konservasi tertentu terhadap besarnya erosi dari tanah yang diolah menurut arah
lereng. Pengaruh aktivitas pengelolaan dan konservasi tanah (P) terhadap
besarnya erosi dianggap berbeda dari pengaruh yang ditimbulkan oleh aktivitas
pengelolaan tanaman (C), sehingga dalam Persamaan USLE kedua variable
tersebut dipisahkan. Faktor P merupakan perbandingan besar erosi dengan lahan
yang sudah di konservasi khusus seperti pengolahan tanah menurut kontur atau
teras terhadap besarnya erosi pada tanah yang diolah searah lereng dalam keadaan

identik atau tidak berdimensi (Arsyad, 2010:369)
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Tabel 2.3 Penentuan Nilai CP Berdasarkan Jenis Penggunaan Lahan

No Penggunaan Lahan Nilai
CP

1 Hutan :

a. Tak terganggu 0,01

b. Tanpa tumbuhan bawah, disertai seresah 0,05

c. Tanpa tumbuhan bawah, tanpa seresah 0,50
2 Semak :

a. Tak terganggu 0,01

b. Sebagian rumput 0,10
3 Kebun:

a. Kebun — talun 0,02

b. Kebun — pekarangan 0,20
4  Perkebunan :

a. Penutupan tanah sempurna 0,01

b. Penutupan tanah sebagian 0,07
S Perumputan :

a. Penutupan tanah sempurna 0,01

b. Penutunpan tanah sebagian, ditumbuhi alang - alang 0,02

c. Alang — alang, pembakaran sekali setahun 0,06

d. Serai wangi 0,65
6  Tanaman Pertanian :

a. Umbi — umbian 0,51

b. Biji —bijian 0,51

c. Kacang — kacangan 0,36

d. Campuran 0,43

e. Padi irigasi 0,02
7  Perladangan :

a. 1 tahun tanam — 1 tahun bero 0,28

b. 1 tahun tanam — 2 tahun bero 0,19
8  Pertanian dengan konservasi :

a. Mulsa 0,14

b. Teras bangku 0,04

c. Contour cropping 0,14

Sumber : Asdak, (2002:376)

2.5 Kelas Tingkat Bahaya Erosi

Menurut peraturan Menteri KehutananNo.50 tahun 2009, bahwa tingkat
bahaya erosi diklasifikasikan dalam lima kelas. Data klasifikasi tersebut dapat
ditentukan setelah melakukan perhitungan menggunakan Persamaan USLE.
Klasifikasi tersebut menggambarkan tingkat bahaya erosi yang terjadi. Data
klasifikasi tersebut dapat digunakan sebagai pedoman untuk perencanaan

pengelolaan tanah. Seperti yang disajikan pada Tabel 2.4.
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Tabel 2.4 Klasifikasi Tingkat Bahaya Erosi

Kehilangan tanah

No. Kelas TBE (ton/ha/th) Keterangan
1. I <15 Sangat ringan
2. II 16-60 Ringan
3. I 60-180 Sedang
4. v 180-480 Berat
5. \Y > 480 Sangat berat

Sumber : Kementerian Kehutanan, (2009)

2.6 ArcGIS

ArcGIS Geostatistical Analayst adalah suatu extension (program
tambahan) atau fitur tambahan dari ArcGIS yang dapat digunakan untuk
pemodalan luasan menggunakan metode dterministik dan geostatistik. 700/ ini
sudah terintegrasi dengan GIS dan memungkinkan menggunakan metode tersebut
untuk analisis lebih lanjut. Output model (hasil interpolasi) selanjutnya dapat
digunakan sebagai model data (baik pada lingkungan model builder maupun pada
pemrogaman phyton), divisualisasikan dan dianalisis menggunakan extension

ArcGIS lainnya (Indarto, 2013).
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4.2.18 BAB 3. METODOLOGI PENELITIAN

3.1 Tempat dan Waktu Penelitian

Penelitian ini dilaksanakan di Laboratorium Teknik Pengendalian dan
Konservasi Lingkungan Jurusan Teknik Pertanian Fakultas Teknologi Pertanian
Universitas Jember dan UPT PSDA Surabaya wilayah Sidoarjo, Surabaya, dan
Mojokerto pada Juni 2015 sampai November 2015. Gambar peta lokasi penelitian
ditunjukkan pada Gambar 3.1 berikut.
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Gambear 3.1Peta Lokasi Penelitian UPT PSDA Buntung Paketingan
(Sumber: Hasil Pemetaan Menggunakan ArcGIS 10.1, 2015)

3.2 Alat dan Bahan
42.19 3.2.1 Alat
Alat yang digunakan dalam penelitian ini antara lain sebagai berikut.
a. Seperangkat Personal Komputer (PC)
Fungsi dari komputer sebagai media kerja untuk memasukkan, mengolah, dan

menampilkan data hasil penelitan;

b. Software ArcGIS
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Fungsi dari software ini sebagai platform operasional, penyusunan, dan editing
layer;
c. Microsoft Excel 2007

Fungsi program ini untuk memasukkan dan memperbaiki data sebelum diolah;

4.2.20 3.2.2 Bahan
Bahan yang digunakan dalam penelitian ini berupa data sekunder antara
lain sebagai berikut.
a. Peta sebaran stasiun hujan untuk menentukan faktor R;
b. Peta jenis tanah untuk menentukan faktor K;
c. Peta tata guna lahan sebagai penyedia data objek untuk faktor (CP);
d. Data DEM dengan resolusi 30 x 30 m data objek untuk faktor (LS);
e. Data curah hujan harian (times series) 10 tahun 2001 - 2010;
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3.3 Prosedur Penelitian
Prosedur penelitian ini diGambarkan pada diagram alir penelitian Gambar
3.2 berikut:

Gambar3.2 Diagram Alir Prosedur Pelaksanaan
4.2.21 3.3.1 Inventarisasi Data

Dalam penelitian ini menggunakan data rentang waktu (time series) dan
data spasial. Data rentang waktu merupakan data yang terdiri dari data curah
hujan harian selama 10 tahun (2001-2010). Data spasial terdiri dari data atribut
dan data obyek. Data atribut terdiri dari data erodibilitas tanah (K), data tata guna
lahan, dan data erosivitas hujan. Data obyek merupakan data yang terdiri dari peta
jenis tanah, peta sebaran stasiun hujan, dan data DEM. Data tersebut didapatkan
dari Laboratorium Teknik Pengendalian dan Konservasi Lingkungan Jurusan

Teknik Pertanian Fakultas Teknologi Pertanian Universitas Jember.

4.2.22 3.3.2 Pengolahan Data Curah Hujan

Pengolahan data curah hujan ini yaitu mengolah data curah hujan harian
menjadi data rata-rata curah hujan tahunan. Tujuan mengolah data curah hujan
tersebut adalah untuk menghitung besarnya erosivitas setiap tahun seperti yang
ditunjukkan pada Persamaan 2.2. Data curah hujan yang digunakan adalah data
tahun 2001 — 2010 dan diolah menggunakan Microsoft excel. Metode yang
digunakan untuk mengolah data curah hujan harian menjadi curah hujan tahunan
rata-rata yaitu metode aritmetika (aljabar).

a. Mengolah data curah hujan harian menjadi curah hujan tahunan yaitu
menjumlahkan semua data curah hujan setiap bulan dalam satu tahun pada
rentang waktu 10 tahun terakhir (2001 —2010).

b. Setelah menjumlahkan data curah hujan setiap tahun pada rentang waktu 10
tahun terakhir, selanjutnya adalah membaginya dengan jumlah rentang waktu
tahun data yang digunakan yaitu 10 tahun (Sosrodarsono dan Takeda,
1999:27). Seperti ditunjukkan pada Persamaan 3.1 sebagai berikut:

Keterangan:
: rata-rata curah hujan (mm)

n : jumlah tahun
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: curah hujan di setiap tahun dalam lima tahun (mm)

4.2.23 3.3.3 Input Layer GIS (Data Obyek) dan Data Atribut

Input layer sebaran stasiun hujan, layer jenis tanah, data DEM dan layer

tata guna lahan yang masih dalam bentuk vektor kemudian dalam bentuk raster.

Data curah hujan yang telah diolah kemudian diinput sebagai data atribut untuk

masing-masing stasiun hujan dengan cara menambahkan field baru pada Open

Atribut Table.

4.2.24 3.3.4 Pengolahan Layer GIS

a.a.

a.b.

a.c.

a.d.

Faktor Erosivitas (R)

Untuk menghitung nilai erosivitas dapat menggunakan Persamaan Bols 2.2

menggunakan Microsoft Excel. Selanjutnya interpolasi penyebaran erosivitas

IDW (Inverse Distance Weight). Output hasil interpolasi berupa layer faktor

R dalam bentuk raster.

Faktor Erodibilitas (K)

Untuk mendapatkan nilai K maka layer jenis tanah yang telah diinput dengan

nilai K untuk setiap jenis tanah dikonversi dari format vektor ke format raster.

Untuk mengkonversi menggunakan 7oolbox Conversion Tools > Polygon to

Raster.

Faktor Panjang Lereng (L) dan Faktor Kemiringan Lereng (S)

Nilai LS dihitung menggunakan Persamaan 2.3 dengan pemanfaatan data

DEM. Data DEM tersebut diolah menggunakan tools Extension Spatial

Analyst dan Flow Accumulation dengan bantuan Spatial Analyst Tools. Untuk

menghasilkan layer faktor LS digunakan Raster Calculator seperti berikut.
LS =Power(facc*30/22.1,04) *Power(Sin(Slope*0,01745)/0.09,1.4)

Faktor Vegetasi Penutup Tanah dan Pengelolaan Tanaman (C) danTindakan

Konservasi Tanah (P)

Untuk menghasilkan layer CP diperoleh dari hasil konversi layer jenis tanah

yang telah diinput dengan nilai CP diubah dari format vektor ke format raster.

Untuk mengkonversi menggunakan 7oolbox Conversion Tools > Polygon to

Raster.
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4.2.25 3.3.5 Penggabungan Layer GIS

Untuk melakukan penggabungan layer GIS semua layer faktor harus
ditampilkan dalam format raster. Menentuakan besarnya prediksi erosi setiap
satuan lahan harus dilakukan perkalian dari setaip faktor penyebab erosivitas
hujan (R), erodibilitas tanah (K), panjang lereng (L) dan kemiringan lereng (S),
konservasi tanah (C) dan penggunaan lahan (P) dengan menggunakan raster
calculator sesuai dengan Persamaan (2.1) dengan mengalikan dari tiap faktor
penyebab erosi dilakukan setelah overlay dari data penyebab erosi. Output yang

dihasilkan berupa peta laju erosi dengan satuan ton/tahun.

4.2.26 3.3.6 Klasifikasi (RECLASS)

Dari nilai prediksi erosi yang telah dihasilkan kemudian diklasifikasikan
sesuai tingkat bahaya erosi pada Tabel 2.3. klasifikasi ini dilakukan dengan
menggunakan Reclassify pada Spatial Analyst Tools.

4.2.27 3.3.7 Pembuatan Layout Peta Tingkat Bahaya Erosi

Langkah yang harus dilakukan untuk pembuatan layout peta tingkat
bahaya erosi yaitu dengan mengaktitkan Layout View pada Toolbar View untuk
menampilkan peta tingkat bahaya erosi. Setelah layout tingkat bahaya erosi
muncul kemudian ditambahkan legenda, skala, grid, arah mata angin, dan judul
peta melalui Toolbar Insert pada jendela ArcGIS. Setelah itu peta diekspor dalam

format jpg dengan menggunakan 7Toolbar File > Export.
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4.2.33 BAB 5. PENUTUP

5.1 Kesimpulan

I.

Laju erosi yang terjadi wilayah UPT PSDA Surabaya antara 0 - 4319814,4
ton/tahun dengan total laju erosi 1637,08 ton/ Ha/ tahun. Sedangkan rata-rata
laju erosi diperoleh nilai 44,54 ton/ Ha/ tahun. Hal ini menunjukkan tingkat

bahaya erosi yang tinggi dari erosi yang diperbolehkan.

. Di wilayah UPT PSDA Surabaya mencakup lima kelas bahaya erosi yaitu

sangat ringan (1,32 ton/ Ha/ tahun), ringan (34,35 ton/ Ha/ tahun), sedang
(110,15 ton/ Ha/ tahun), berat (304,92 ton/ Ha/ tahun), dan sangat berat
(1186,33 ton/ Ha/ tahun).

. Tingkat bahaya erosi berat 180 — 480 ton/ Ha/ tahun pada kecamatan Trawang,

Kabupaten Mojokerto sebesar terjadi sebesar 1186, 33 ton/ Ha/ tahun seluas
3641, 31 Ha dengan presentase 1,80% dari total luas.

5.2 Saran

I.

Perlu dilakukan konservasi tanah dan rehabilitasi lahan untuk mengurangi laju

erosi yang terjadi.

. Perlu mengunakan metode selain USLE untuk menghitung besar sedimen dan

kedalaman tanah. Hal ini bertujuan untuk menjadikan parameter perhitungan

besar pengaruh dari kikisan tanah oleh air hujan dan kepekaan terhadap erosi.

. Perlu di lakukan survei lapang untuk mengetahui besar laju erosi dan sebagai

pembanding hasil prediksi.
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